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This chapter describes all aspects of typing, editing and importing text.
Once you have created a simple document, it explains how to save and
print the document, and finally how to quit Ovation Pro.
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3.1 Typing & Editing Text Word Wrap

You can type and edit text whenever there is an Ovation Pro automatically re-formats text to fit
active frame containing the caret. A later chapter into the active frame, so there is no need to press
will describe how to draw your own frames, but Return at the end of each line. If a word is too
this chapter assumes you have opened a new long to fit on a line, it is automatically transferred
document as described in the previous chapter to the start of the next line. Similarly, if a word at
(see 2.4). You should have a document window the beginning of a line is reduced sufficiently in
open, with the caret in the default master frame length for it to fit on the end of the previous line,
ready for text entry. The Select tool should be  then it will be automatically moved up.

chosen(fig. 3.1). New Paragraph & New Line

Try typing a few words at the keyboard. The carePress Return to start a new paragraph, putting the
moves to the right of each character as you type. caret at the start of the next line. You can

The style and format of the text you type is optionally add white space at the end of a
determined by the style call@bdyt ext . By paragraph to separate it from the next paragraph.
defaultBodyt ext uses the font Arial (equivalent This is calledSpace after (see 5.4).

to Helvetica) at a size of 12pt, and is suitable for ChooseMisceI nser t<>New line or press Shift
general-purpose word processing. Return to start a new line, without starting a new
Type more words until you have filled a completeparagrapl{see 5.1).

line. If necessary the window automatically scrollgye,, paragraph and new line characters may be

sideways so that the portion of the page you are ge|eted, causing paragraphs and lines to be joined
editing always remains in view. back together.

The entire text in a frame or in a number of linked
frames is referred to asstory.

Fig. 3.1 - The Select tool.
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Caret Movement Deleting Text

If the Select tool is chosen, and the pointer moved#ress Backspace to delete the character to the left
over an active text frame, the pointer shape of the caret, or Delet\e to delete the character to
changes to thext insertion tool (fig. 3.2). You the right of the caret.

may position the caret by clicking with this tool:  pregg shift Backspace to delete the word before

» If you click within some text, the caret appearsthe caret, or Shift Delete to delete the word
at that position. containing the caret.

» If you click beyond the end of a line, the caret Press Ctrl Backspace to delete from the caret to
appears at the end of that line. the start of the line, or Ctrl Delete to delete from

« If you click in an empty frame, the caret the caret to the end of the line.

appears in the top left corner of the frame. Press Ctrl Shift Delete to delete the line at the
caret. This also deletes a Return or New Line at

The caret may also be moved using the cursor :
the end of the line.

keys on the keyboard:

PN Caret left/right one character You may also delete selected blo¢gese 3.7).

Tl Caret up/down one line Automatic Page Creation/Deletion

"~ "~ Caretleft/right one word If text fills the default master frame, a new page is
Or e Caret up/down one paragraph added with its own master frame. The text then
HomeEnd Caret to start/end of line flows automatically into that frame. This process
non Caret to start/end of text story is calledautomatic page insertion and the frames
A0Or ~0O0  Scroll up/down through story are said to b&nked.

Where” andOrefer to the Ctrl and Shift keys.  |f you delete sufficient text from a document to
Tab Key leave the default master frame on the last page

completely empty, the last page is deleted. This is
calledautomatic page deletion. This only happens
if the last page does not contain any additional

Pressing Tab inserts a tab character into the text,
causing subsequent text to be aligned to the next
tab stop. The default tab stops are at 10mm :
intervals, but these may be changed if required objects.

using the tab rulefsee 5.5). It is possible to alter this behavioseg 15.12).

Transposing Characters

A common typing mistake is to transpose
character pairs e.fjei | d andot f en. This can
easily be corrected by positioning the caret
between the two characters and pressing

Ctrl Shift Q.

I

Fig. 3.2 - The Text Insertion tool.
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Force Page Break Document Info
Menu>oMiscvInsert->New Page Ctrl+Return Menu>File>Info

You can force a page break in the default master ~goseFile I nfo to display a dialogue box that

frame at any time by pressing Ctr+Return or ;65 information about the documéfig. 3.3).
choosingMisc>Insert=>New page). This inserts

a new page and forces the text after the caret to
the top of it. Date is the time and date stamp of the file. If the

document has not been saved, it is the time and
pdate the document was created.

Document is the name of the document.

Doing this in a multi-column frame will force the
caret and following text to the next column. Wit
linked frames the caret is forced to the next linkedsize is the size, in bytes, of the entire document
frame. (in bytes).

The page break character may also be deleted, Story sizeis the size of the text story containing
causing text that follows to flow back onto the  the caret (in bytes).
previous page, the previous column or the

previous frame Words s the total number of words in the

document i.e. all stories.

Moving Around Pages _ Wordsin story is the number of words in the text
Once you have a document with a number of  story containing the caret. If a selection has been
pages, you may use the following keys to move madeSelection words gives the number of words

around the pages. selected including partially selected words.

UPage Up Start of previous page Page is the current page number i.e. the one in the
LPage Down  Start of next page centre of the document window.

APage Up Start of first page in chapter Total is th ber of in th

"Page Down Start of last page in chapter do a pagt&s IS the humber of pages in the

APage Up Start of first page in document ocument.

~OPage Down  Start of last page in document Chapter is the current chapter number.

“Cursor Up ~ move page down one line Total chaptersis the number of chapters in the
ACursor Down move page up one line document.

Where * means the Ctrl key, andhe Shift key.

You can also move directly to any page using
M enur>Page>Goto page (see 11.1). F5

Remember that the number of the page shown on
the info palettdsee 2.7) is the one present in the
centre of the document window.

About this file K|
Document 03 Text.dpd
Date 1:32 28th March 2004
Size | BRI =election size _

Waords | 5143 Selection waords

Page| 2¢ Total pages| 20

Chapter| 1 Total chapters| 1

Fig. 3.3 - The document Info dialogue box.
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3.2 Inserting Special Characters Hard hyphen inserts a non-breaking hyphen.
M enussMiscel nsertes. . Words separated by a hard hyphen are never split
between linegsee 5.7). Ctrl+Shift+ -

There are a number ways of inserti_ng special Soft hyphen inserts a soft hyphen that doesn’t
characters and control sequences into a docume%lppear until it is needed to split the word at the

Insert Menu end of a lingsee 5.7). Ctrl+ -

TheMisc=>Insert menu allows a number of Mergetag inserts a field for the mail merge
special control characters to be inserted at the  facility (see 12.5).

caret(fig. 34). Fixed Space opens a window allowing you to
Chapter number inserts the current chapter insert a custom shift. The shift can be both
number. horizontal (as with a normal space) and vertical.
Page number inserts the current page number. ~ YOU can enter the size of the shift in absolute units
, for example inches. Alternatively ifnits

Dateinserts the current date. The date format ma /1000 is checked the units used are thousandths

be set irChoices (see 15.5). Ctr#D 5t an em, the advantage of this is that the space is
Active date inserts the current date which is proportional to the font size. As elsewhere
updated automatically each time the document isQvation Pro takes the em space size as the point
loaded. The date format may be se€Chmices size of the font.

(see 15.5).

Two other options are provided, the inserted space
Timeinserts the current time. The time format  can be made non-breaking (see hard space above).
may be set itChoices (see 15.5). Finally the space can beddimiter. A delimiting

The Choices window is selected via: space is used to break up text into words, whilst a

’ non-delimiting space adjusts the spacing between
characters. To understand the relevance of this
think about counting the number of words in some

Menu=>Misce>Choices...0........ Characters

New pageinserts a page bredgee 3.1). text with spaces in - how do you decide where
Ctrl+Return words begin and end? There is a text effect in

New line starts a new line, but not a new Ovation Pro that underlines words, delimiting

paragraphl{see 5.1). Shift+Return spaces in common with normal spaces would not

Hard space inserts a non-breaking space. Words be underlined, non-delimiting space would be.

separated by a hard space are never split betweelfithe caret is before an existing fixed space in text

lines. Ctrl+Space  when the window is opened the values in the
window will show the values for the space, and
when the window is closed the new space will
replace the old one.

It is possible to enter negative values for the shifts.
Chapter numkber
Page number % insert space  HE|
Disie L Vertical | Omim|
Active date
T Harizantal | Ormm
Mew page Cirl+Return ™ Units em/1000
Mew line shift+Feturn
Hard space Ctrl+Space I™ Mon-breaking
Hard hyphen Chrl+Shift+ I Delimiter
=oft hwphen Ctrl+-
Mergetag... Chrl+Shift+hd Cancel oK
Fixed space...

Fig. 3.4 - The Insert menu. Fig. 3.5 - The Insert space window.
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Menu=>Misc>Characters F11 displayed. This menu is not available unless the

Most fonts contain a wide range of special document feature level is greater than 4.

characters that are not accessible directly from thinserting Characters using Alt

keyboard. You can easily obtain these using  The icon at the bottom right shows the keypress
MiscvCharacters. This opens a dialogue box  for the highlighted character. This is useful if you

displaying all the characters in the character set, wish to insert special characters directly from the
for the current fon(fig. 3.6). Just click on a keyboard using the Alt key.

character to insert it at the caret. The selected
character will be inserted in your document and )
y from the keyboard by holding down Alt and

the Characters window will close. If you want to yping the code number on the numeric keypad.

insert more than one character, right click the firs : .
characters and left click on the last character youRNhen Altis released, the character is inserted at
the caret. So to type the bullet character ¢, hold

want down Alt, type 0149 on the keypad, and then
You can change the font displayed, using the fontelease Alt.

menu at the top of the dialogue box. This font is
used for the inserted characters only and any
typing afterwards will be in the original font i.e.

the one that was current before opening As an alternative you can use the “United States-
Characters. International Keyboard Layout”, when this is

The fieldsBold andltalic are automatically ticked enabled the right Alt key in combination with

depending on the font chosen from the font menuother keys can be used to generate extra
haracters. See “How To Use the United States-

nternational Keyboard Layout in Windows XP”,
Microsoft Knowledge Base ID : 306560. This

feature is available in older versions of Windows
You can put the caret into these icons and type ingo.

glyph names or coc_JIe values and the hightlight W”JAnother possibility is to use the Windows
move to the matching character.

Character Map program. This is accesible from
The character set menu at the bottom of the  the Windows Start Menu->Accessories->System
window lets you choose which selection is Tools. However note that not all characters are

Characters m

Font I Timas New Roman ﬂl [T Bold [ ltalic

You can type characters not normally accessible

A full list of codes is given il\ppendix B.

The icons below the character grid show the glyp
name of the highlighted character and its code
number in decimal and hexadecimal.
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Fig. 3.6 - The Characters dialogue box.
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available inOvation Pro unless Unicode support Single Shift Font (SSF) F12

has been enabled by setting the document featurghis facility allows you to switch to another font
level to 5 or greater. to insert a single character and then return to the
If the document feature level is 5 or greater previous font. The default single shift font is
another technique can be used. Type the Symbol which contains a range of symbols, but
hexadecimal code number of the character into tH&U can choose another fqsee 15.7).

text and then pregslt+X this will replace the Single shift font is accessed using the key F12.

code number with the corresponding character. Uncertainty principle ApAx~h

The process works in reverse, positioning the
caret just after a character and pressgitig-X will
replace it with its character code.

To produce the line above, typacert ai nty

pri nci pl e followed by a space, then press F12
and type D. Then type p, F12 again, D then x.
This works because in Symbol font, D appears as
the ‘Delta’ character.

You may also use the Alt key to insert characters
not normally accessible from the keyboard.

Jack of Di anonds ¢

To produce the line above, typack of

Di anonds followed by a space, then press F12,
hold down Alt, type 0169 on the keypad, and then
release Alt. This works because the diamond
character has code number 169 in the Symbol font.

SeeAppendix B for a full list of characters in
Symbol font.
Combining SSF and Characters

If you press F12 before openi@paracters, the
font used inCharacter s will be set to the single
shift font.

Changing Single Shift Font (SSF)
Menu>Misc>Choicesw Text

TheChoices menu allows you to set the SSF.
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3.3 Importing Text

Instead of typing in text, you may drag text files

CHAPTER 3

Importing Ovation Pro documents
It is possible to import a@vation Pro document

directly from disc. The imported text is inserted atinto another as separate chapfees 11.6) Of

the pointer position and takes the style of the

preceding text.

If you import text into a frame that is too small
and that frame isn’t linked, the text will overflow

(see 8.3).

course you can also import the contents or a
selection of them from on@vation Pro

document into another either by dragging or by
Copy andPaste. In these cases if certain styles of
a document from which the text is taken do not
exist in the document to which the text is

Text files can also be inserted by using Import onimported, these styles will be addade 6.8).

the File menu, this will let you use the standard
Windows Open dialogue to find the file.

You can load a text file using Open on the File
menu causing a new default document to be
opened and the text file inserted into it.

Stripping Return Pairs

If you hold down the Ctrl key when dragging a

Importing Other Types of files

Please refer to th®vation Pro release notes for
details of other formats that may be imported.

If you attempt to import a file that is not
supported, you will be asked to confirm whether
you wish to procee(fig. 3.7). If you do proceed,
only the text content of the file will be imported.

text file into a document, single Return characters
in it will be converted to spaces and pairs of
Return characters will be converted to single
Return characters. This is useful when importing
text from text editors which terminate each line
with a Return, since i@vation Pro the line

breaks will not necessarily fall in the same places.
If Ctrl is not held down while importing text,
Return characters will be unaffected.

Smart Quotes

When text is imported, plain single quotation
marks (') or double quotation marks () enclosing
text are converted to fancy open and closing

single (") or double (*”) quotation marks
respectively. This gives a more professional
appearance to quotations and expressions such as
“fish ‘n’ chips” and “rock ‘n’ roll”.

This facility is called ‘smart quotes’ and can be
disabled if requiredsee 15.7).

T Ovation Pro 7] |

ﬁl'-(Ll Inserted file is of type Data (*.dat) not
4 Text. Are you sure you want to proceed?

N\

Mo | Yes

Fig. 3.7 - The text import warning box.
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3.4 Undo & Redo
M enuc>Edite>Undo

Undo

Edit=>Undo (fig. 3.8) cancels the last operation
performed, restoring your work to its previous
state. You can undo anything that changes a
document, such as deleting or editing text,
changing styles or manipulating objects. You
cannot undo things that just change the way a
document looks e.¢/iew menu options.

Ctrl+zZ

A special feature oDvation Pro is that you can
undo more than one operation. The number of
undo operations that can be performed depends
upon the size of the undo buffer which can be
increased or decreased as requfsed 15.5).

Unbpo & Repo 27

Redo Ctrl+Y

Redo cancels the last undo operation performed.
TheRedo option will be shaded if there is no
further operation that can be re-done i.e. the
document is up-to-date.

Note that if you edit a document after using undo,
theRedo function will not be available.

Clear undo buffer
Menu=>Misce>Clear undo buffer

Whilst the undo buffer is automatically flushed
when you save a document, you may need to flush

it manually if you run out of memory when
editing a document. You can do this using the
optionMisce>Clear undo buffer. This minimises

the memory used by a document by flushing the

Undo is shaded if there is no further operation thagndo buffer and recovering any memory used by

can be undone.
By default, the undo buffer is automatically

deleted objects.
Saving the Undo Buffer

flushed before saving a document. This mean¥ou can use an option @hoices which causes
that after the document has been saved, you the undo buffer to be saved with documents

cannot undo operations that were carried
before saving.

(see 15.5).
Making Undo Use Less Memory

There are three reasons for automatically flushingyhen you delete an object such as a frame or

the undo buffer before saving a document:
As you edit a document, deleted objects are

picture, that object is retained in memory and a
reference to it placed on the undo buffer so that

retained so that they can be put back. Flushinghe deletion can be undone. As a result even with

the undo buffer when the document is saved,
recovers the memory used by these objects.

It ensures that the saved document uses as
little disc space as possible.

Anyone receiving the document cannot use
undo to see the contents of previous versions.

Undo Deselect Ctrl+Z
Beda (Sl
Cut Picture frame el -+
Copy Ficture frame  Cirl+C
Paste cliphoard el -+
Delete Ficture frame  Cel+k
Efmbied chjest

Select all i+,
Clear

Eitl... i+

Fig. 3.8 - Undo and Redo

a very small undo buffer, it is possible that
significant amounts of memory may be used
storing deleted objects. Eventually, as other
operations are carried out, references to deleted
objects are pushed off the undo buffer and the
objects are removed from memory.

So, if you have little free RAM available for your
document, you may wish to disable the undo
buffer completely so that deleted objects are not
retained. You can do this by setting the undo
buffer size on the Choices window t@%e 15.5).

Alternatively, you could save the document at

regular intervals, since this has the effect of

flushing the undo buffer and deleting any

referenced objects.

The exact text following the words$ndo
andRedo on theEdit menu is context
sensitive and is not mentioned here.
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3.5 Revert to Saved
MenuFilecoRevert to saved

Revert to saved restores the document to the

most recently saved version. A warning prompt is
displayed before proceediffig. 3.9). Click on
Discard to delete the current document and reload
the previously saved one, or Gancel to cancel

the operation.

Revert to saved is shaded and unavailable if the
document has not changed since it was last saved
or if it has never been saved.

T Ovation Pro 7] |

Fevert to previous version of file and
discard this version?

&0

Discard | Cancel |

Fig. 3.9 - The Revert to saved warning box.

CHAPTER 3
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3.6 Selecting Text Clearing a Selection

Many operations are applied to a text selection. There are a number of ways to clear a selection:
The selection may be any amount of text from a « Click once anywhere in the document.

single character to an entire story. +  ChooseEditeClear (fig. 3.9)

There are a number of way to select text: .
» Select something else.

1. Left click and hold down the mouse button at

the start of the text to be selected, drag to the Overtyplr?g . ] .
end of the text and then release. Note that if you type anything while text is
selected, the selection will be deleted and replaced

2. Left click to position the caret at the start of with the text typed.

the text to be selected. Hold down Shift and ) - . )
Left click at the end of the text. Further Left  This facility may be disabled ddhoices
clicks with Shift can be used to adjust the (see 15.7).

range of the selection at either end.

3. Use one of the following short-cuts:

» Left Double-click with on a word to select that
word including following spaces;

» Left Triple-click on a line to select that line;

» Left 4 clicks anywhere in a paragraph to select
that paragraph;

» Left 5 clicks anywhere in text to select the
entire story

4. Chooseedit>Select all to select all the text in
a story. Ctrl+A

5. Hold down Shift and use the usual caret
movement keys. For example Shift + Home
will select all the text between the start of the
current line and the caret.

After any of these operations the selected text is
highlighted, i.e. inverted (normally white text on a
black background).

Note, it is not possible to have more than one
region of text selected at any time.
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3.7 Cut, Copy, Paste & Delete Transferring Text Between Documents
Menu=>Edite ... Ovation Pro uses special rules to deal with

TheCut, Copy andPaste options on thédit clashing style names when using cut, copy and

menu(fig. 3.8), are used to move or copy text paste between documents.

within the same document or to another documenthe situation occurs when text containing a
defined style is transferred to another document

which contains a style of the same name, and that
style has a different definition. If this situation
occurs, by defauldvation Pro renames the style

in the transferred text. So if you eBibdyt ext

in one document and then transfer it to another

Please note that if there is no selected text, the document containinodyt ext , the transferred
following options are used to manipulate other  style will be rename8odyt ext 01.

selected objects, such as frames, pictures or ”nei\lternatively you may use an option Ghoices.

Cut text Ctrl_+X MenuroMisc>Choicesw> Text
Cut deletes the selected text and places it on the

clipboard. The previous contents of the clipboard that causes the clashing style name to be
are overwritten by this operation. discardedsee 15.7). Then the transferred text will

take over the style attributes from the receiving
Copy text CtrlI+C

document.
Copy copies the selected text onto the clipboard.
The previous contents of the clipboard are
overwritten by this operation.

Paste text Ctrl+V

Paste inserts the text that is on the clipboard into
the document at the caret. Text can be pasted into
anyOvation Pro document, not just the one from
which it was cut or copied. After pasting, the
clipboard contents remain unchanged so you can
paste more than once.

They do this via a clipboard, which may be
viewed using th€lipboard option on the View
menu. Text or pictures are displayed on the
clipboard in exactly the same format as they
appear in the document.

The above rules for clashing style names, also
apply to clashing colour names.

UseCut followed byPaste to move text.
UseCopy followed byPaste to copy text.

Delete text Ctrl+K

Delete deletes the selected text. It does not place
the deleted text on the clipboard. This option is
only available if there is some text selected.

You may also delete selected text by pressing
Delete on the keyboard.

If Overtype has been set iBhoices
Menu>oMisco TextoOver type

selected text will be deleted when entering new
text.
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3.8 Drag & Drop Transferring Between Documents

Instead of usingut, Copy andPasteto move or  The rules given earlier for dealing with clashing
copy text via the clipboard, you can use the drag Style and colour names when using cut, copy and
and drop facility to do this directly. paste, also apply to drag and d{sge 3.7).

To use drag and drop, first select the text you wistserting Pathname

to move or copy. Left Click over the selection so Holding down the Alt key and then dragging a file
that the drag and drop tool is display@d. 3.10).  or directory from a Windows Explorer window
Now drag until the pointer is over the required  into anOvation Pro document, will insert the full
insertion point and release the button to insert thegpathname into the text.

text.

If you drag and drop within the same document,
the text ismoved; if you drag and drop to another
document, the text iopied.

If you hold down Shift while dragging, the above
operations are transposed. So, if you drag and
drop within the same document, the textdpied;

if you drag and drop to another document, the text
is moved.

If you start a drag operation and wish to cancel it,
press Esc.

i

Fig. 3.10 - The drag and drop tool.
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3.9 Find & Replace Case Sensitive

Menu=Edit=FEind Ctrl+F If Case sensitive is not selected, the search will
match all occurrences of the search string, making
ne distinction between upper and lower case
Characters. So searching fdvc  will match with

Edit=>Find opens a dialogue box which allows
you to search a story or document for a string, an

optionally replace the found string with another abc, Abc andABC etc. The replace string will

string (fig. 3.11). match the upper-case/lower-case format of the
By default if there is no selected text, the search found string. So replacing withqr in the

starts at the caret and continues to the end of theexample above givgsqr , Pqr and PQR.

story. If there is a selection, only the selection is If Case sensitive s selected, the search will only

searched. : .
match occurrences of the search string with
The options in th&ind dialogue box are exactly the same upper-case/lower-case format.
described below. So searching foAbc will only match withAbc
and notabc or ABC. The replace string is
MenuesEditesFind next F3 substituted unchanged.

. . Whole Word
Edit=>Find next searches from the current f Whol di | 4 th b wil
position for the next match of the previously used oleword Is not selected, the search will
search string. This provides a quick way of match occurrences of the search string even if
resuming a search perhaps after doing some boundgd by other letters and numbers. S0
editing around a string found searching foher would match witht her e and
' ot her.

_ If Wholeword is selected, the search will only
Find match occurrences of the search string that are not
Type in the string that you want to search for.  bounded by other letters and numbers. So
Pressing Tab in this field will place the caretin  searching foher would match witther and
the Replace with field below. (her), but not witht her e andot her .

Replace with

Type in the replacement string that will be
substituted for the search string when it is found.
Leave this field blank if you do not want to
replace the search string or if you want to delete
the search string.

Pressing Return in either the Find or Replace field
will start the search i.e. it is equivalent to clicking
onGo.

HE|
Find || =]
Replace with I LI

[T Casesensitve [ Wholeword [ All stories

[7 Find from stat | Wildzcards I Count |

Cancel | Go

Fig. 3.11 - The Find dialogue box.
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All Stories Go

If All storiesis not selected, the search starts at Click onGo to start the search. If the search string
the caret and continues to the end of the story. If cannot be found, the messdgs f ound is
there is a selection, only the selection is searchedlisplayed in thé-ind dialogue box. Click on

If All storiesis selected, the search starts at the Cancel to close the dialogue box.

caret and continues through each story until the When the first occurrence of the search string is

end of the document. Butkind from start is found, theT ext found dialogue box is displayed
selected as well the search starts at the beginningfig. 3.12), indicating the operations available. The
of the first story. found string is selected in the document.

Find From Start Click onContinue to find the next occurrence of

If Find from start is not selected, the search the search string.

starts at the caret. Click onReplace, to replace the search string with

If Find from start is selected, the search starts ~ the replace string, and continue to the next
from the beginning of the current story rather tharpccurrence. If the replace string is blank, the
the caret position or start of the marked area. It isfound string will be deleted.

useful if you wish to search an entire story but  Click onEnd of file replace to find and replace
have forgotten to, or do not wish to move the caref|| occurrences of the search string without

to the start of the story. stopping for further instructions.

Find from start does not apply if you have a Click on Stop to abandon the search.
selection or ifAll storiesis selected. In the latter

case it starts at the beginning of the first story in
the document.

If the search string cannot be found, the message
Not found is displayed. Click oistop to close
the dialogue box. Alternatively €ontinue is

Count clicked on searching will recommence from the
Click onCount to count all the occurrences of the start of the story or iAll storiesis selected, from
search string. The number counted is displayed irthe start of the document.

the icon to the left of th€ancel option.

Count acts in the same way as stated above under
the section®\ll Stories andFind From Start.

Previous searches

Pressing cursor down in the find or replace fields
allows you to step through previous search and
replace strings. When the search field is changed
in this way the replace field will change to the
corresponding replace string. However stepping
through previous values for the replace field will
not change the search field.

Textfound |

Replace

End of file replace

Found

Cancel

Fig. 3.12 - The Found dialogue box.
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Wildcards

Click onWildcardsto display the extenddend
dialogue boxfig. 3.13). In this mode you can
introduce wildcards or special characters into the\ ¢ matches the chapter number
search string (and in one case, into the replace \e embedded frame

string).

CHAPTER 3

Although not displayed in the extended Find
dialogue box the following wildcards can also be
used:

\ f new frame

To insert a wildcard, position the caret correctly in 9 page number
the search string and then click on the required \h  active date
wildcard icon. The escape sequence for that
wildcard is inserted into the string. If you wish
you may type the wildcard escape sequence
directly into the string.

In the following table, the escape sequence is
shown first, followed by the icon name, followed

by a description of the wildcard function.

\.
\d
\a

\*

\ &

\\
\
\'n

\'t

Any char matches any single character.
Any digit matches any single digit O to 9.
Any alpha matches any single alphanu-
meric character. Ato Z, ato z, 0 to 9 and
Any string matches any string of

characters.

Found refers to the string found and is
used in the replace string. For example, if
you search foc\ . t, putting \&s in the
replace string will replaceat ,cot and

cut withcats,

cot s andcut s.

\\=\ matches the \ character.
New line matches the new line character.
New para matches the new paragraph

character i.e. Return character.
Tab matches the tab character.

\'m merge tag

\p new page

\'s fixed space

\'w  one item of white space, i.e. space, non
breaking space or tab

Note\ e,\ m \'s and\ w - cannot appear in the
replace string.

As well as wildcards it is possible to use glyph
names in the search and replace strings. This
allows characters which cannot be entered into
Windows text icons to be used. A complete list of
glyph names can be found in Appendix H. For
example {fl} represents the fl ligature. This does
mean that if you want to search for text that looks
like a ligature name an extra { must be used. So
{{fl} will find the text {fl} in the previous

sentence.

Macro expansion is supported in the find and
replace stringgsee Chapter 17).

Find Iﬂ:uund

Replace with I

[~ Case sensitive

[7 Wholz word [ All stories

| Find from start  [v Wildcards I Count
L Any charactar W Any digit Ya Any alpha
VoAny string & Found Bo=h
U Mew ling ‘n Mew paragraph it Tab
Cancel Go

Fig. 3.13 - The extended Find dialogue box with wildcards.
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3.10 Saving Documents Saving Text Stories
Menu=File>Save As... In addition to saving entire documents, you may
To save the document chodsger>Save As.... Just save text stories.

The standard Windows Save window will appear TO Save a text story, position the caret in the story,
(fig. 3.14). If the document, hasn’t been saved ~ and choosé&ile>Save story. Now use the

before, a default name will be supplied e.g. standard save box to save the story as a plain text
Docunent 1, Docunent 2, etc. If you want to file. You may also save the storyDL format
change the name, edit it in the usual way. by choosinddDL before savingsee Appendix J).

Ensure tha©vation Pro is selected for Save as 10 save selected text, select the text required then
type, and click on Save. An icon representing thechooserile<>Save selection. Now save the file in

file appears in the Winows explorer display to  the usual way.

confirm that the file has been saved and the name

of the file is updated in the document window title

bar.

You may also save documents in DQdog¢ument
description language) format by choosin@pDL
before savingsee Appendix I).

Menuc>Filec>Save Ctrl+S

If a document has already been saved and has a
full pathname assigned to it, it can be resaved with
the same filename by using this entry on the file

menu.
Save As |

Save In; I _A tanual j gl

| 112_Examples @) 07 _Wiew. dpd #]15_Custorn.dpd & Appendix_D.dpd =] I
@] 00_Cortent.dpd  [#] 08_DrawObj.dpd  [#] 16_Colours.dpd &) Appendix_E.dpd

] 01_Intro.dpd & 09 WorkOb.dpd  [#]17_Macros.dpd & Appendix_F.dpd
=] 02_Started.dpd  [#] 10_Pictdpd &) 15_Appletdpd &) Appendix_G.dpd
] 03_Textdpd #]11_Pagesdpd  [#]19_Scriptdpd & Appendix_H.dpd
=) 04_Fffectdpd ] 12_Print.dpd &) Appendix_Adpd  [#] Appendix_|dpd

#|05_Formatdpd  [#]13_Print++.dpd  [#] Appendix_B.dpd  [#] Appendix_J.dpd
=] 06_Style.dpd =] 14_Spell.dpd =) Appendix_Cdpd  [#] Glossany.dpd

« | [
File name: Save
oave as ivpe:  |Chwation Fro j Cancel

Fig. 3.14 - The Save dialogue box.
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3.11 Basic Printing Pause

Menu=FEile=>Print... Ctrl+P If Pause is selectedQvation Pro will pause
between each page printed until you click on
Continue on thePrinting dialogue box (see
overleaf).

Before you can print, you must load a printer
driver suitable for your printer. Ensure that the
printer driver has been configured correctly, for
such things as resolution and number of colours. Reverse

ChooseFilecoPrint or press Ctrl P to display the If Reverseis selected, the order of printing is
Print dialogue boxfig. 3.15). The name of the ~ reversed.
current printer driver is displayed in the title bar. Collate

A brief description of the options on tReint If Collate is not selectedvation Pro prints
dialogue box is given below, but more detailed ~Multiple copies of each page, so pages are printed
information is given later in this user guide in the order 1,1,1, 2,2,2, 3,3,3.

(see12.2). If Collateis selected when printing multiple
Copies copies,Ovation Pro prints multiple copies of the

Copies s the number of copies of each page that document, so pages are printed in the order 1,2,3,
you want to print. 123123

No Pictures

If No picturesis selectedQvation Pro will

ignore pictures and just print text. Only the picture
frame guideline is printed. On some printers

Format

Format should be set thlormal the first time
you start a print job.

All Pages . ' printing pictures is very slow, so this option may
All pages prints all pages in the document. be useful for quickly printing draft copies.

Range allows you to print the range of pages Tumble

specified in the writable field. If Tumbleis selected andll Sidesis selected,

All Sides then printing on the even sides will be rotated by

All sides prints both left and right hand pages. 180 degrees. I eft/Right or Front/Back are

L eft andRight allow you just to print one side of selected all printing will be rotated by 180 degrees.

the document. This is useful if you want to print aPrint Setup

double-sided document by printing one side then Print setup extends thé&rint dialogue box to

turning the paper over and printing the other. provide further advanced printing options
(see 12.3).

Chapter 12 gives information on many advanced
printing options available.

2 Print 1]
Printer HP Caolor Laserlet PS E
Copies| 1|+ ] Format Mormal Bl

& Al pages " Range 19 to 38

& Al sides ™ Right i Left

[ Pause [T Reverse [ Collate

I Mo pictures [ Reflect I~ Tumhble

[ Print setup et Cancel Frint

Fig. 3.15 - The Print dialogue box.
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Set

Click on Set to set the options in tHerint
dialogue box, without actually printing the
document. These options will be saved with the
document when it is saved.

Print

Click onPrint to print the document. The pointer
changes to an hourglass and Fnenting dialogue
box is displayedfig 3.16). It shows thd”age and
Copy being printed.

The green bar gives a visual indication of how
much of the print job has been completed, but
please note that this is only accurate to the nearest
whole page.

Click onCancel to terminate printing. Please note
that only a limited amount of multitasking is
possible when printing i.e. when the hourglass
turns back to the standard pointer. So there may
be a delay befor€ancel takes effect. Usually it is
quicker to press Escape instead.

Click onPause to pause printing. Again, there
may be a delay befoRause takes effect. When
paused, th€ause option changes tGontinue
which you should click on to continue printing.

Printing BigDoc.dpd |

F'agel 215 CDp'_I,I'I 1 Record [
Separation %—
[

Fause | Cancel |

Fig. 3.16 - The Printing dialogue box.

Basic PrinTING
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3.12 Closing Documents & Quitting

When you have finished working on a document,
close it by clicking on the close icon of the
document window. If the document has been
modified since it was last saved, a warning will be
displayed(fig. 3.17). Click onSave to save the
document before closing it; click discard to

close the document losing the latest changes; click
on Cancel to cancel the close operation and retain
the document in memory.

If you have finished usin@vation Pro, you can
remove the program from the computer’s memory
by choosingexit on theFile menu(fig. 2.2).

Again, you will be warned if your document has
been modified since it was last saéd. 3.18).

Click onDiscard to quitOvation Pro losing the
latest changes made to any modified documents,
or click onCancel to cancel the quit operation.

¥ Ovation Pro H E3 |

This document has been modified?

& _.

Discard | Cancel Save

Fig. 3.17 - Confirm box when closing a modified document.

1 Ovation Pro = E3 |

1 document modified.

Discard | Cancel |

Fig. 3.18 - Confirm box when quitting Ovation Pro.
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